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AnalyticsFinanceRead MoreRead MoreRead MoreRead MoreRead MoreRead MoreSAP PlatformSAP ServicesRead MoreSAP BPC Events VIEW FULL LIST The International Convention Centre, The International Convention Centre, Broad St, Birmingham B1 2EA SAP Business Planning and Consolidation (BPC) tool is used to support all operational and financial activities of an organization. SAP BPC
helps automate and streamline your organization's forecasting, planning and consolidation activities. SAP BPC supports two types of migration: SAP NetWeaver and Microsoft Excel. PCB with the Microsoft version allows you to perform modeling, application maintenance, data importing and processing application, script creation, etc. It leverages the power of MS Excel and provides the user with an
enterprise power management (EPM) solution, a collaborative tool with a robust and easily accepted environment. SAP PCB supports existing Microsoft features and various improvement features such as drag and fall report builder, etc. Here are the main benefits provided by SAP BPC - It allows the user to make better business decisions by supporting What-If analysis and allows you to perform scenario-
based planning. It allows you to collaborate on data and increase the accuracy of business planning and accountability. It helps align your plans with strategic goals and thus reduce cycle time. You can choose the version of SAP NetWeaver or Microsoft Platform. Here are the key benefits that can be achieved by using PCB - Business Forecasting Analytical Reporting and Analysis Budget Planning
Predictive Analysis and Recommendations Improve Compliance Consolidation Business Process Flows and Smooth Collaboration What is EPM? SAP Enterprise Performance Management (EPM) enables your organization to improve its financial and operational performance management. SAP EPM supports a variety of features with SAP Business Planning and Consolidation - BPC-NW or BPC-MS, such
as financial consolidation, financial information management, supply chain performance management, strategy management and many other areas. SAP BPC NetWeaver vs BPC MS SAP Business Planning and Consolidation NW version is based on the features of the NetWeaver platform. This is built on NetWeaver HTML5 and supports various user environment features. It also provides various pre-built
components to reuse in different applications. The SAP BPC NW supports the RESTful connection to the ABAP backend component and provides regular access to the user interface. It also supports recording capabilities Client. The following table shows the name of the platform and the components supported - Microsoft Windows Vista 32-bit and 64-bit client, MS windows 7 32-bit and 64-bit Window
Server 2003, 2008 and 2008 R2 terminal server 32-bit and 64-bit Microsoft Office 2007, 2010 and 2013 Internet Explorer 9.0 and 10.0 Mozilla Firefox 17 and more Apple Safari for iPad iPad iPad and higher versions NetWeaver Application Server Any OS supported by NetWeaver SAP NetWeaver 7.4. Refer PAM for the SAP PCB supported database for NetWeaver offers various benefits as it is integrated
into the BW system and allows you to store data in InfoCubes. Some of the key benefits of using SAP PCBs with the NW system are Star Schema for Exceptional Reporting - SAP BPC uses NW InfoCubes to store data. The size model used is extended stellar pattern so that it makes BPC with NW system and exceptional system for reporting. No database dependency version - PCB version NW does not
depend on the database version and can run common databases like DB2, Oracle, SQL Server, etc. BW Accelerator Support - SAP NetWeaver BW accelerator tool is an additional feature that can be used to improve reporting performance in the system, even if you use large datasets. It indirectly helps to save the cost for a business because fewer performance problems are reported. BAdI Development
and ABAP Support - SAP PCB with NetWeaver lets you use ABAP programming to develop the logic of the K2 script. It allows to create the BAdi enterprise interface add-in in the back-end system, which can be called later from the script logic developed in the BPC system. It helps solve the complex needs of the business and reduce the development time of an organization. Some key benefits of using
SAP BPC MS are - in addition to the common features provided in PCBs such as currency translation, allocations, account validation and transformations, automatic adjustments and carry-over of the opening balance, the following features can be achieved in the BPC MS - Logic Dimension - version of which can be configured in the BPC system using simple mathematical formulas. Business Rules - This
allows you to create rules in the PCB system to perform specific functions. K2 Script Logic - This is used to perform specific functions that cannot be performed using out-of-box features to meet business requirements. You can create K2 script logics to perform certain functions, which can be performed in a standard system. Many organizations use MS Excel to manage business planning and consolidation,
but they have some drawbacks. Here are the drawbacks of using PCB MS on NetWeaver - Hard to manage Excel spreadsheets - As business planning and consolidation data is stored as spreadsheets, this creates a security problem and an option to control access is to keep the files on the shared network. In SAP PCBs, you can store the data in the database, which ensures data security. Version Control
- To create a new version of the data, SAP BPC with NW allows you to keep the version of the data in the system and you can also maintain the current data. When you use Excel spreadsheets for the data store, you need to name the file with a new name each time. Spreadsheet Integrity - Using spreadsheets, it is difficult to manage the integrity of the spreadsheets because the same file is accessible by
multiple users and it is difficult to the latest version of the spreadsheet. However, the SAP system has a central repository to maintain financial and business planning data. Collaboration - SAP PCB allows you to collaborate with different user data and you can comment on critical information and Excel doesn't support the collaboration feature. SAP BPC with NetWeaver Architecture Requirement - SAP
NetWeaver ABAP 7.3 or 7.31 Database - One of the above versions of SAP NetWeaver support. Operating system - Any supported version of the SAP NetWeaver system and the database engine. The following figure shows the SAP BPC 10.0 architecture. SAP NetWeaver BW Objects Difference between SAP BPC v7.5 and v10 is the Web Server component. SAP BPC 7.5 NetWeaver uses Microsoft ISS,
while BPC 10.0 NW and BPC 10 on HANA use the web server that is part of SAP NetWeaver. SAP NW 10 is more scalable than SAP NW 7.5 (IIS in 32bit mode) and simplifies system topology because no separate web server and network load balancing components are needed as these were part of PCB 7.5 implementations. Another difference between the two is the version of SAP NetWeaver. SAP
BPC 7.5 NW supports SAP NetWeaver 7.01 and 7.02. However, SAP BPC 10 NetWeaver and BPC 10 HANA does not support NW 7.01, 7.02 versions. Also note that the NW 7.01 and 7.02 requirements are very different from SAP NetWeaver 7.3. This means that SAP PCBs 7.5 NW systems in many organizations are running on older versions of operating systems and RDBMS is not supported by SAP
NetWeaver 7.3. Here are the main items NetWeaver BW - SAP BPC Objects According to the architecture above, here are the key objects of BPC 10.0 - Customer Interface - At the top, you have a customer interface that is a web tool used for configuration and reports for business planning. It consists of an MS Office client, Excel-based admin clients and a web reporting tool. The Microsoft-based
administration tool is used for app configuration and Microsoft Office tools such as Word and PowerPoint are used for data communication. Web server and .NET application server - This tool uses web services to connect to .NET Application Server. It receives the request from the client interface and directs all requests to the ABAP server, which is part of the SAP NetWeaver BW system. This server is
used for data conversion between customer tools and sap NetWeaver BW. SAP NetWeaver Application Server - This server is used to process all customer tool requests. The request for the .NET application server is processed in this server under the name Remote Function Call RFC. This is used to requests to create reports or update the database. When a request is processed by the application server,
it receives the data and transmits it to .NET Application Server, and then returns it to the client interface. Database Server - This layer is responsible for storing all data in the database. Sap NW back-end system is responsible for creating objects and data is stored for the PCB system. The NetWeaver supports most databases like SQL SQL DB2, Oracle and many others. Release Strategy Here are SAP's
output notes for SAP BPC 10.0 - Product Version 10.0, SAP NetWeaver Area CPM-BPC BPC now supports the following platforms - Server Support - Any operating system supported by SAP NetWeaver. VMware support according to SAP. Virtualization, VMware, Microsoft, Windows, Hyper-V, XEN, vSphere, IBM, INxHY, KVM, zBX. SAP NetWeaver support for NW 7.3. No support for older versions.
Database Support - PCB supports all databases supported by the SAP NetWeaver system. Customer support - Microsoft Windows, WIN XP (32 bits), Windows Vista (32 bits and 64 bits) and Windows 7 (32-bit and 64-bit). Microsoft .Net Framework .Net Framework 3.5 is required. Web browser support - PCB supports web browsers - IE 8.0 and IE 9.0. Microsoft Office Support - Microsoft Office 2007 (32
bits and 64 bits) and Microsoft Office 2010 (32 bits and 64 bits). .NET server is no longer needed in the latest PCB versions. SAP BPC - Terminologies Comparing BPC 7.5 and BPC 10.0, here are the main terminology differences between the two. BPC 7.5 BPC 10.0 AppSet Dimensions of the Environment Dimensions Dimensions Applications Business Models Validation Control of Parameters Script Logic
Script Script Work Status Settings Work Settings Journal Templates Journal Templates System Settings Audit Report Settings Environment - It is defined as the starting point for creating an application or model. It has been called App Sets or AppSet in older versions of PCBs. Dimensions - You can mark a dimension as secure. You must give users who use the model access to read and write so they can
access the data. Properties - This is used to provide additional information to the dimension. Dimension Members - Each size member record shows the master, text and hierarchy data associated with the dimension keys. Model - To meet the planning and consolidation requirements of an organization, you need to build a model in an environment defined as a multi-dimensional collection. Package Data
Manager - To perform common tasks in PCBs, you need a data manager package. Trade Rules - To manage operations in different countries, different trade rules are required. BPC includes a rules-based table to meet certain business planning and consolidation requirements. Various rules can be defined related to business planning and consolidation such as currency conversion, balance deferral,
intercompany elimination, data validation, etc. Logic Scripts - This is a SQL or MDX programming structure to perform certain custom functions for flexibility and manage data models. When specific requirements are not met using business rules that can be met by using logical scripts. User - A user is defined as someone who uses the app in Appset. Team - A team is defined as a user group based on user
roles. Task - All activities that are SAP BPC system are called tasks. SAP PCB - Applications An application in the PCB system is defined as a multidimensional data model used in EPM. Few examples of applications are - Operation, Legal or Finance Team. There are two types of applications in the PCB system: reports and non-reports. Reporting applications are used for analysis and you can transmit
user inputs. Non-reporting applications are used to contain reference data such as exchange rates, carry-forward balances, etc. An Appset consists of one or more applications in the system. Each application consists of the key data of an application, which is used to control the data in the set of applications. An app can also share one or more dimensions with other apps. Application Architecture Each
reporting application consists of one dimension, properties to contain additional information, and dimension members. Consider a consolidation rate application, which consists of the Rate to Store Exchange Rate application and a proprietary application, which stores the relationship between the owner company and its subsidiaries. Consolidation Property Rate Account (A) O_Account (A) R_Account (A)
Category (C) Category (C) Category (C) Entity (E) Entity (E) R_Entity (E) Groups (R) Groups (R) InputCurrency (R) Time (R) Time (R) T) Time (T) Time (T) Interscicities (I) Interscicities (I) DataSource (D) Flow (S) Creating applications and applying dimensions To add an application to the set of applications , you can use an existing app by selecting reference apps and any set of business rules. You can
also add dimensions to the new app and these can be defined as secure or unsecured. When you define dimensions as secure, it ensures that access to reading and writing is controlled by user profiles. You can add an app via an admin console - App → Add a New App To copy an app - App → Copy an app To create a consolidation app, you need to set AppSet for consolidation and the defined dimension
for consolidation. You need to set the following settings after the app set is created. ALLOW_FILE_SIZE UPLOADTEMP TEMPLATE JREPORTZOOM LOGLEVEL SYSTEM MESSAGE STATUS In the SAP PCB NetWeaver version, all of these parameters are maintained in the ABAP DDIC table. Once the app set is created, the next step is to set up the Dimension set settings. You can add a new
dimension or copy an existing dimension. In the administration console, go to Model. Move on to dimensions and patterns → dimension. Click on 'News → Enter ID, Description, Type → Create To create a tariff application that contains the exchange rate, the following dimension types are needed - C_Acct (A) - to maintain account charts. C_Category (C) - Define the category. Groups (R) - such as GROUP
A (USD), GROUP B (EUR) and GROUP C (RMB). Entity (E) - It contains the business unit used to derive the process. C_Datasrc (D) - Data source dimension. IntCo (I) - It hierarchy level of entities at what level the elimination should be carried out. Time (T) - Time in all dimensions. Flow (S) - To track consolidation movements. To create a tariff application that contains the exchange rate, the following
dimension types are required - R_Acct (A) - to maintain different types of rates. InputCurrency(R) - Currency type dimension. C_Category (C) - Define the category. R_Entity (E) - Tariff application. Time (T) - Time in all dimensions. To create a property, the Consolidation app contains property information. The following dimension types are required - O_Acct (A) - for ownership C_Category (C) - To define
the category entity (E) - It contains the business unit used to pull the process. IntCo (I) - It determines the level of the entity's hierarchy at what level the elimination should be performed. Groups (R) - Used to implement a separate type of group. Time (T) - Time in all dimensions. To set up a consolidation application, three applications are required: rate, ownership and consolidation. SAP BPC - Model
Design With the release of BPC 10.1 with NetWeaver, there are two models that can be used to meet business requirements. PCBs are often called PCB applications and the PCB environment is normally called application. PCB Construction Models The following types of models can be built in PCBs - Standard Model This model offers an option in the BW host's protected name space /CPMB/. When you
separate PCB transaction data and master data within the nominative space (CPMB/), all sub-processes associated with the standard model are tightly secured and closely managed by the department running the application. This model is designed by SAP to provide a protected area for customers who plan and consolidate in their own department without wanting to share or coordinate resources with
other users in the Business Warehouse community. As the Standard model code set has been coordinated with the PCB 10.0 version so that all changes to the PCB 10.0 model are displayed in the standard PCB 10.1 model and changes to the PCB 10.1 Standard Model are displayed in the BPC 10.0 version. This allows code compatibility between PCBs 10.0 and PCBs 10.1, and customers can easily
migrate while improving the PCB version from 10.0 to 10.1 Standard Model. In short, you can tell in the standard model, PCB environment contains PCB applications or models and each model generates a BW InfoCube that is hidden. Integrated Model This model is different from the standard model and includes access to data to all users in the community. For the on-board design model, sap BW
Integrated Planning and Planning Application Kit, i.e. BW-IP and PAK. This model offers a different level of data access where master and transactional data from the EDW host environment is accessible through the application. In the Embedded model, it allows easy access to transactional and master data within the BW host, and this data is shared with many other users and and by the group of directors.
In the Embedded model, the migration of older versions of Business Warehouse IP, BW-IP to this data model is relatively easy and the migration of earlier versions like (BPC 10.0 and earlier) is considered a new implementation. In short, you can say that in the built-in model, any number of InfoProviders can be attributed to a single PCB/application model. Environmental Management A PCB application is
also known as a model, as an environment is called an AppSet. You can create an app by going to the Admin console in enterprise performance management (EPM) System. PCB environment or AppSet has the group of applications or models. All of these applications share planning dimensions and are linked to each other. As mentioned earlier, applications are called multidimensional data models in
EPM. You can add a new app or also copy an existing app. Environmental management includes setting up the state of work of applications and adding business rules to applications. Determining the state of work in the working state of the environment determines who can make changes to the data or who can change the working status on the data set. In environmental management, you can also
optimize applications. When a new app is created, it contains only a small amount of data. Over time, the data in the application increases and it is always recommended to optimize the performance of applications in the PCB environment. Removing an application in environmental management It is also possible to remove any application in the PCB environment when necessary by going to the admin
console. You must be an administrator to perform this function. Dimensional management in BPC includes the creation of new dimensions, the definition of members in dimensions and the allocation of properties. Dimension contains member and there is a hierarchy between members that is defined as parent, child and brother and sister. You can create a new dimension by going to Admin Console →
Dimension → New Dimension. The size name is not sensitive to the case and it should be unique. When adding a new dimension, you need to enter the reference type. Planning and consolidation verify the value of the reference type when processing the dimension. Click Create the button in the window above. You need to enter the referential integrity for the type of rate in the new window. Click on the
'Save' icon. You can also change the structure, change members, delete or copy an existing dimension. To copy size, select an existing dimension and go to Copé. Enter the name of the dimension and description. Click the 'Copie' button. Name conventions in dimensions - You should not use special characters while naming a dimension, member and application in the BW table. You can create the size
name up to 16 characters and it should not contain comma, double comma, back slashes, ampersands. However, you can use the underlining. You should not use the following names - App, AppAccess, AvlObject, CategoryAccess, CollabDoc, CollabIcons, CollabRecipient, CollabRecipient, CollabType, DBVERSION, Defaults, DesktopStyleDef, Dimension, DrillDef, DTIParam, Function, Formula, Group,
InvestParam, MemberAccess, MessageLog, Packages, PageDef, Permission, PublishedBooks, Rate, ReportParam, SectionDef, Status, StatusCode, TaskAccess, User, UserGroup, UserPackages, UserPovDef, WebContents, SOURCE, SIGNED. The size description should not be more than 50 characters. You can remove a dimension by selecting it and clicking the Delete button. The design of the PCB
security security model is managed in the Administration console. You need to log in to the PCB portal and go to the planning and consolidation administration. There are four key elements in PCB security - User Teams Task Profiles User Data Access Profiles - This is used to add users to the environment and manage their access rights. Teams - It's not that important and you can set a team of users with
the same access rights. Task Profiles - This allows you to set up profiles for the tasks to be performed and assign them to users and teams. Data Access Profiles - This is used to set up profiles that allow access to data in models and assign it to users and teams. Click on the Team tab under Security, select the Admin team and double-click. You'll see team name details - ADMIN, which users are part of this
team, task profiles, and data access profiles. You can change team details and click on the Save icon to apply changes. By going to the user tab, you can add new users, change existing users and delete any user. SAP PCBS - Loading data loading data into PCBs is done with the help of Data Manager who allows you to move data through the planning and consolidation system, copy and move data, and
export data from an application. Data Manager moves data as packages, allowing planned sequences to run in the background and some can initiate other processes. Loading data from the source system to the cube in SAP NetWeaver BW We can extract data from different source systems such as SAP ECC, SAP CRM, SRM using extractors. You can also load data from non-SAP sources to InfoCube in
the SAP BW system. To load the data in InfoCube, go to the BW system workbench. Transaction Code: The RSA1 data storage facility will open, go to Source Systems on the left side. Data acquisition in the BW system can be done using the following methods - API Transfer Service Flat Files DB Connect Universal Data Integration XML Based Data Integration Third party ETL tools Application Specific
Data Acquisition Creating a Source System Double-click on File and enter logical system name, source system name, Type and Release. Next, it's about creating an InfoSource for feature data. Click right on the right InfoSource pane → application component. Once you've created infoSource, click right on it and assign the data source. Then click right on the Source → InfoPackage system, select the key
data and save. Describe Load Characteristics. Finally, create an InfoSource for transactional data. Create update rules and a package of information to load Data. Loading data from SAP NetWeaver BW to SAP BPC You can load data on the PCB system from SAP BW InfoCube. With BPC Data Manager, you can use PCB code packets. You can copy or move data in different applications and export data
from applications. PCB packages are based on BW process chains and are available with the BPC installation. Data Manager Tool is integrated with Excel. To start PCBs, move on to planning and consolidating → eTools → Data Manager. In Data Manager Package, there are different data transfer modes - Aggregate Overwrite Append While you're loading Info Provider's data, you have the following
options - PCB also supports the Delta load because many records are generated for each load. Delta initialization is possible with a higher upgrade package and you can perform the Delta load in the Organize under the Data Manager tab. In the BW system, full load is supported for standard infocubes, virtual infocubes, standard objects and optimized DSO data storage. You can load Delta using Data
Manager for InfoCubes Standard and Standard, Optimized DSO. Then is to create a package that contains the conversion file and the transformation file with variables, which is responsible for triggering a BW process chain. You can combine different packages for separate tasks in the package links. The creation of the Transformation File Transformation file provides field mapping from BW to PCB and is
an Excel file in PCBs. It contains transaction data from Info Objects in BW with PCB dimensions defined in the ad administration console. There are three sections set for file mapping - Options - Contains general settings. Mapping - Used to assign a dimension in the PCB system with a source column in BW InfoObject. Conversion - Contains the link of other Excel sheets to apply the conversion routine. To
create a transformation file - Go to the PCS Excel client. Then you have to choose the set of applications and the application where these transformation files will be used. Now go to Data Manager in business planning and consolidation → more → new transformation file. You'll see an Excel sheet with three sections - Option, Mapping and Conversion. You don't need to make changes to Option,
Conversion. Switch to mapping and mapping transactional data from InfoObject in BW to BPC Dimension. Example OF COMPTE - ZACCOUNT TIME - ZBPCTIME SIGNEDDATA - ZAMOUNT Note that you can also copy an existing transformation file or update an existing transformation file by going to More under the Corporate Planning and Consolidation ribbon as shown in the following screenshot.
Creating a conversion file A conversion file is used to apply conversion rules for the PCB dimension and is an Excel file. It contains three sections - External - Contains the external source value. Internal - Contains the value it should have for the PCB dimension. Formula - Sets the conversion formula applied to each record. To create a conversion file - Switch to the PCB Excel client. Choose AppSet and
Application where these transformation files will be Switch to Business Planning and Consolidation Ribbon → More → New Conversion File You can also use other functions like - Manage the conversion file, copy the conversion file, etc. Loading Flat File's master data in one dimension You can load the data into the PCB dimension from flat source files like CSV, XLS. You must first create the dimension
using an administration console and a connection must be established. Go to PCPS Excel → EPM tab and click on the log on the left side panel. Select the login name, username and password. Go to the Data Manager → ePM tab → download data. Enter the name and click 'Save'. Create a transformation file as mentioned above. If the number of fields is the same for the source and destination, no need
to use the mapping. You will only have values under the Options section and the rest of the fields would be empty in this Transformation file. If you have the source and target with a different number of data columns, you should define it under the map as for the description in the screenshot above. Once the Transformation file is created, it is then a matter of validating and processing the transformation.
Select the type of → Master data from a flat file and click on the Save icon. Go to the 'DM' tab at the top of PCB Excel → Run Package. Click Data Management and select the import master data attribute from the flat file. Click 'Run' at the bottom and enter the path to the data file and the transformation file as created above. Select the size in which you want to download this data and click 'Run'. Once it is
successfully completed, you can go to the web portal to check the data under Dimension. SAP BPC - Reporting SAP BPC 10.0 allows you to obtain data from source systems to an Excel interface. It allows you to analyze multidimensional data and BPC 10.0 provides the number of built models that can be used for analysis and you can also add different formulas to the reporting design. SAP BPC 10.0
offers a variety of outstanding features, including integration with SAP HANA on BPC 7.x to manage the big data environment for reporting purposes. SAP BPC also provides the use of entry schedules that allow you to send the report data to the database. Entry calendars provide you with all the features available in PCB reports. The difference between report and input calendars is that reports are used to
analyze data and input calendars are used to write data to the database. You can among the following methods for creating reports and timelines for entering the business planning and consolidation tool. Using default models EvDRE Builder Drag and Drop Interface Blank Workbook SAP EPM Add-In Interface for Excel You can also create reports in business planning and consolidation EPM Add-in for
Excel. Excel PCB Interface is largely divided into the following sections - EPM Add-In Ribbon Connection and Dimension EPM Context Menu Report Area To create reports in the add-in EPM interface for Excel, you need to activate the following option. Go to EPM → Options → Sheet Options→ check the box Enable the Member Member You can simply drag the dimensions and drop them to excel leaves.
This is the simplest method and displays the report based on the size selected from the list of available dimensions. Another option to create a report using the Excel add-in is to add dimensions to the line axis and column axis. Once you add dimensions click 'Update'. You can also create reports by simply typing the size member into the report area. The add-in BPC Excel identifies the member and
displays the result. EPM Add-in Versions Next are the two versions of EPM Add-ins - EPM Add-in .net 3.5 It supports MS Office 32 bits. It degrades performance if you query using the ODBO connection. It works on .net 3.5 frame. It supports the .msp file. It does not support high-volume BV mode. EPM Add-in .net 4.0 It supports MS Office for both 32 and 64 bits. It supports BV mode on BW data sources.
It provides performance optimization if you interview using the ODBO connection. It also supports the file .msp (must uninstall/reinstall). It supports BW connections for the built-in model. Reporting development using dynamic models There are different models in the sample application set and you can select one of them and customize them to meet the requirements of the report. Using this feature, it
allows you to save the report locally or on the server. When you change an existing report, you can also save it as a template for future use. The PCB administrator may only be allowed to register the custom report as a template on the server, but you can save them locally. Here are the default templates in PCBs - Subtotals by Account This custom report contains the account dimension with line sub-tals
and any dimension across in the columns. Variance This custom report contains any dimension in comparing lines and categories in columns. It also includes the calculation of deviations (both the amount and the percentage). With YTD and Periodic boxes. Consolidation This custom report contains any dimension in lines and Entity-type members across in columns with hierarchy. Comparative X This
custom report contains any dimension in the comparison of lines and categories in columns and also retrieves data from the same period last year. With YTD and Periodic boxes. Comparison with the 3-year year comparison from one year to the next. Drill in place This model makes a drill in place. This allows two dimensions to be nested in a row and one dimension in the column. Sorting on the value This
model sorts over the total value. Drilling Size This allows the drill to be used in one dimension to another. Launch ePM Office Excel Add-in, to use a template. These models are available in the Company folder and they are created using ADD-in PCBs not like PCB 7.x where models are created using EvDRE. Reporting using EPM functions There are three ways to create a report in PCBs. You can create
simple reports using the EPM action pane by dragging dimensions and dropping them into the report area. You can add dimensions to the direct axis as shown in the next screenshot. Similarly, you can create reports using the action glass. Migration of EvDRE reports All reports that have been created in PCB 7.5 Excel can be migrated to PCB 10.0 using the Excel EPM add-in. The EvDRE migration
function in Add-in is used to migrate as many features as possible to a new version, but custom reports and templates can only be partially migrated and require some manual effort for a full migration. Migration EvDRE Reports to PCBs 10.0 Open reports created in EvDRE. Update the report to have correct dimensions migrated. Next stop at EPM Ribbon → More → EvDRE Migration. Develop reports
using sap BPC Web Client To access business planning and consolidation, you can connect to a web client. To launch the web client, open the web browser and use the URL - :port/sap/bpc/web/ When you connect to the PCB web client, the first screen that opens is the starting page and the home tab. If you want to create reports using Web Client, you can go and create an area that has the following
options - New workspace New Entry Form Go to report again and the next screen will open. In the dropdown menu, select a new report, entry form. On the right side, you have a list of available dimensions. You can add dimension to the line and columns as needed. You can also edit existing reports. It is optional to postpone the layout of the report. If you select this option, it won't change the layout of the
report. SAP BPC - SAP PCB Planning provides you with an end-to-end planning process and performs activities such as planning, forecasting, budgeting, reporting, etc. It allows you to follow top-down or bottom-up planning with an app and user interface. Planning Process In planning and consolidating activities, the planning process is supported by automation and workflows. It allows you to create
reports and entry forms that can write to the database. With the reporting interface, you can get data from databases to excel spreadsheets and entry forms allow you to send data directly to the database. Entry forms contain the same features and formats as reports, only the difference is that the reports are used for analysis and the input forms are used to send data to the database. Planning models
Different modeling options are possible with input forms to meet planning needs while sending data to the database. Spread modeling option allows you to send a value to specific destination cells. This value can be evenly distributed or weighted by the range of values. Trend - The trend modeling method allows you to allocate a value or percentage and distribute it by a growing factor in the destination
cells. You place the source value in the first destination cell and the rest of the cells are on the ground with an increased value of a certain amount or percentage. Weighted - It allows you to assign a set of weighted factor values in Excel sheets. In this, you select certain values, cultivate them, and then allocate the new amount according to the weights of the selected cells. Thus, the entry forms provide you
with a special modeling function to help you in your Needs. Entry forms/entry schedules Note that entry forms are the terminology used in BPC 10, while entry schedules have been used in BPC 7.x. However, in the end, they both represent the same thing. Entry forms allow you to disseminate Excel sheet data directly to the database and contain all the features that are present with reports in PCBs. The
difference is that entry forms write data into the database and reports are used for analysis. Entry forms support the following features - Data Submission - If you have enough access permission, using entry forms, you can send data to the database. If data validation is authorized by the system administrator, you can also validate the data and make sure there are no work lock and validity issues on
members. Modeling options - Various modeling options can be used with entry forms - Working State - After sending the data to the database, you can modify the work state locks to apply data locks. Distribution and Collection Option - You can send entry calendars to different members using the distribution option, and then retrieve entry schedules using the collection option. Use of special formalities -
You can also apply special formatting to read cells only. Entry time models There are different models provided in the system that you can use and apply customizations as needed. Here is the list of dynamic schedule models that are available in the system. Account Trend or Entity Trend This calendar contains Account-type members in the lines and periods in the columns, using the EvDRE functions.
Entity Trend This calendar contains Entity-type members in Entity-type lines and members in columns, using EvDRE-based functions. Consolidation This calendar contains Online Account members and Entity-type members in the column, using EvDRE-based functions. Nested Line This schedule allows you to choose the dimensions and members of the line, column and page. The two-row dimension can
be selected and will be nested. It also uses EvDRE functions. Comparison This calendar contains Account-type members in rows and category-type members in columns with a variance column, using EvDRE-based functions. The development of an entry calendar entry form can be developed using the methods Dynamic models using EvDRE using Slide and Drop To create an entry form/schedule using
drag-and-drop, connect to the web client. In the type select the entry form. You can also add dimensions by clicking on sign. You can drag the dimension to the lines and columns from the list of available dimensions and once you're done click Save. Enter the name of the entry form and description and click Save. Integration with the SAP BO dashboard You can also view real-time data from
BusinessObjects Planning and Consolidation via dashboard designer. To create Dashboard with PCBs, you need to install the dashboard designer and add ePM Connector Add-on to the dashboard designer and connect to EPM data using the EPM connector. Once the connector is is you can use pcb in real-time data to create dashboard. Go to the Analyzer tab in Dashboard Designer. Then go to Edit the
report. It will invite you to add a new connection. Click Add a new button. Select the sap BusinessObjects Planning and Consolidation data source from the dropdown list and click 'Connect'. It will open a new promotion window for the name of the PCB server, username and password. You need to enter the same credentials you use to connect the PCB Excel client. Once you enter the details, click 'Next'.
Select the AppSet and finish the assistant. Select the cube from the dropdown list that contains the data you need to use and select the data source name. Then select the newly created connection and click 'OK'. Once you click ok, it will open the Report Manager output, which can be used to design the report output. These are the steps that can be used to integrate Dashboard Designer with SAP
BusinessObjects Planning and Consolidation BPC tool. There are different features in the dashboard designer that can be used to create an interactive dashboard, which can be used by decision makers. SAP BPC - Business Logic You can perform enterprise logic and script logic on PCB data. There are different calculations that can be done. Business Rules - There are monetary functions that are used to
display common accounting tasks in the business planning and consolidation model. Script Logic - This includes formulas that are used to perform different calculations on PCB members, dimensions and data. Dimension Logic Dimension Logic is used to apply calculations and formulas on dimensions. The calculations are made according to the size formula at the time of recovery. It is important to use
size formulas correctly as they can affect system performance if misused. Key points to remember when applying Dimension logic - The Dimension formula affects system performance so that it is applied correctly. Size formulas should only be applied to members for whom calculations are required after aggregation. Size formulas should only be used for ratios that need to be calculated at the base and
parent levels. Common Dimension member formulas are used to perform calculations - costs per unit, growth rate, etc. How to define logical dimension? You need to be familiar with multi-dimensional expression language to create formulas Complex. The list of supported MDX functions is available from BAPI_MDPROVIDER_GET_FUNCTIONS modules. Preconditions - To use a size formula, you need to
add a property called Formula to members' sheets using the option to manage the size task. You also need to set the length of the field and it should be more than 60 characters. Higher field lengths are preferred because any length greater than 60 is stored as a chain in SAP NetWeaver. If you want to use the Dimension formula in AppSet, you need to maintain a special-sized R-type member. This
member is called local (LC). A set of applications → select members of the support dimension. The formula can be created manually or taken from a library-sized formula. To define the member dimension formula, you need to put a square support around the dimension and there is a point in between. [PRODUCT]. [PRODUCT1] - [PRODUCT]. [PRODUCT2] [SALES]. [SALES1] / [SALES]. [SALES2]
Standard arithmetic functions must be used in the dimensional formula - addition, subtraction, multiplication, division ,/) - these are used in SAP NetWeaver. Once you save the size formulas, the next one is to validate the syntax. Logic Scripts Logic scripts allow you to automate PCB calculations for financial statements. Business Rules Business rules are used to customize the task of manipulating data
such as bulk data imports with currency translations, database entry data, etc. Business rules can be changed using table-based logics or script-based filters. Table-based logic provides that the features available in the UCON accelerator and script-based files can be customized using the MDX or SQL syntax. You can set business rules for the following activities - Deferral Rules - Includes the initialization
of balances at the beginning of a new fiscal year. Validation Rules - Validates input data. Currency Conversion Rules - Converts local currencies into currency used in PCB reports. Intercompany Booking Rules - Corresponds to intercompany transactions. Automatic adjustments and other calculations. To manage business rules in the PCB system - Go to administration as shown in the next screenshot. Go
to the rules and → business →. Script Logic With the help of script logic, you can write your own logic in the SQL or MDX language. There are different MDX functions that can be used in dimension formulas. Some of the common MDX features are Avg - Returns the average value of a digital expression. Account - Returns the number of tuples in a set and also includes zero cells. Max - Returns the
maximum value of a digital expression. Min - Returns the minimum value of a digital expression. Sum - Returns the sum of the digital expression. There are other MDX functions that can be used in dimension formulas. Examples of simple rule formulas [PRODUCT]. [PRODUCT1] - [PRODUCT]. [PRODUCT2] [SALES]. [SALES1] / [SALES]. [SALES2] Standard arithmetic functions must be used in the
dimensional formula - addition, subtraction, multiplication, division ,/) - these are used in SAP NetWeaver. Once save the size formulas, the next one is to validate the syntax. Examples of Advance Rule Formulas This includes moving computational dimension formulas from one period to the next. [AccRec] Accounts receivable [AccPay] Accounts payable Mvmt Acc Rec Movement in accounts receivable (if
([Time]. CurrentMember.Children.Count - 0,[Account]. [AccRec]-[Count].[ AccRec],[Time]. PrevMember) SUM (Descendants[Time]. Current member,[Time]. [Month],LEAVES)))) Mvmt inventory Movement in Inventory (if([Time]. CurrentMember.Children.Count SUM (Descendants[Time]. Current member,[Time]. [Month],LEAVES) Syntax to create script logic in dimension formulas are already covered.
Exceptions in MDX Syntax Following are exceptions to the MDX syntax by PCB - Replace the keyword AS with a sign of O (equal). Do not use simple quotation marks around expressions. Example [COMPTE]. [#GROSSSALES] - [COMPTE]. [UNITS] [COUNT]. [INPUTPRICE] [ACCOUNT]. [#COST] - [COMPTE]. [#GROSSSALES]-80/100 Worksheet Logic All calculations made in the Excel worksheet are
known as worksheet logic. The worksheet logic includes all the functions available in an Excel spreadsheet and the functions provided in PCBs. SAP BPC - Business functions Business Planning and Business Consolidation performs various business functions such as auditing, business process flows, financial statements and reports, and work status. Various built-in functions are provided to perform these
functions. Currency conversion Currency conversion is necessary if your currency numbers are present in more than one currency in your application set. If the application set contains single currency monetary figures, then you don't need a tariff application, exchange rate dimensions, etc. If most of your data is entered into a currency and you have few numbers in other currencies, this can be managed by
creating duplicate members in the entity dimension. In this case, you can duplicate few entities present in overseas transactions to separate the local currency from the translated amounts. Example: The U.S. company deals primarily in the United States, but it also has few subsidiaries operating in other countries such as Canada and Mexico. Simple conversion requirements There should be a tariff
application where you store exchange rates. You must have an account dimension, which includes RATETYPE. Then the entity dimension must include a property currency. Logic Fxtrans should be available and logic BY DEFAULT should include a call to FXTRANS logic. The size of the feature should include the TRANSALATE_TO. Complex currency conversions There should be a tariff application
where you store exchange rates. The application must contain a CURRENCY-like dimension. There should be ownership reports for the DEVISE dimension. The size of the entity must include the ownership currency. The size of the account must include the RATETYPE property. The FXTRANS logic should be available. The logic BY DEFAULT should include a call to FXTRANS logic. Correct Rate
Selection All types of valid rates correspond to a RATE application account and belong to the GROUP exchange rate. If there is an account is not part of this group, it will be multiplied by a factor of 1. You can also set a particular NOTRANS case, which results in an account being ignored during translation. Cross translation includes multiplying the amount in local currency relative to the destination
currency rate and the source currency rate. Using this, the app can only use one rate table to translate any source currency into destination currency. You can Set the following default translations using business rules - Use different rate tables by declaring the currency. Identify the difference between multiplying currencies and dividing currencies. Intercompany Eliminations To perform currency conversion
and intercompany disposals, you need a type of dimension - intercompany dimension (I). To perform intercompany elimination, an application must have the following dimension - Dimension Type I for intercompany elimination. Dimension I should include a property entity. The size of the account must include the ELIMACC property. The size of the entity must include the ELIM property. You need to set the
appropriate business tables. There should be a TPD package to run intercompany logic. Dimension Property Length Content Account ELIMACC 20 Valid Account Entity ELIM 1 tank It contains 'Y' or blank Intercompany Entity 20 Entity 20 Entity 20 Entity w.r.t Intercompany member Currency Reporting 1 'Y' or blank defaulting logic performs the following functions - Checks all base-level entities where ELIM-
Y. limits the monetary dimension to all declaring currencies only. Deletes all accounts to be eliminated in the desired plug account. Elimination is performed below the first common parent in elimination entity. SAP BPC - Process Flow Management This is used to manage user-created processes and to create and manage business process flow models. To manage business process flows, you need to have
a process management task profile. The process model is defined as a business process, which contains all the tasks that are spread over multiple modules of the PCB system. It includes step-by-step process flow, user activity link, process context and when the process takes place, all participants and their roles. Example A regional manager entering monthly budget data, which includes each manager
creating a process and entering data for each department. To create a new business process model, connect to the → Planning and Consolidation Administration web portal. On the left side, you can see the option of business process flows. Expand this tab and you'll see process patterns and process instances. To create a new business process model, go to tab process templates. Click 'New'. PCB
administrators are responsible for creating and managing process models. Once process models are created, the enterprise user can use the templates to create processes. Work Status The working state is used to lock a data region into a model. This is used to replace the user's members to write to a particular region. There are several dimensions defined for a region with a property called OWN. While
defining the state of work, the following elements are defined - Working State - It belongs to the physical state of the data. Security - You can set different levels of security on changing data in the system - All or locked. You can define who can change the work state - Manager or Owner. Data update - This defines how the data will be updated by the customer. Pushing The option is used to push the same
state of work for all children of a member. Once the work state is set, they can be used by users to lock the data for review and approval, etc. To implement the e-mail notification of the state of work, you need to set the parameters, APPROVALSTATUSMAIL, APPROVALSTATUSMSG, SMTPPASSWORD, SMTPPORT, SMTPTP SERVER, SMTPAUTH, etc. Definition of work status Go to business
planning and administration → features. On the left side, you have the Features tab. Expand this tab and you'll see the working state as the first option. Move to work and on the right side, you will get options to create and manage the state of work. Control the state of work that you can set in the PCB system, which can change the data. This includes the following access levels - Who can change the data?
All of this allows all users with appropriate access to edit the data. Locked - This locks the change on the data. None can change the data. Manager - Only parents of owners/managers can change the data. Owner - Only the owner can change the data. Who can control the state of work? Both - If you choose both the owner of the specific member id and the parent's owner to the specific ID of the member.
Owner - Owner of the member's specific ID. Manager - Owner of the parent's ID to the member. Determine the manager or owner in the basic hierarchies The owners of the parent members act as owners for this specific piece of identification of the parent member and work as a manager for direct children. This allows the owner parent to change the professional status of direct children. In case you select
all the children, the owner of a parent can update the children at all levels. The owners of the core members act only as owners. Members who do not have a parent but have children also act as their own manager and owner. Controlled by the rule An owner is defined by a hierarchy of dimension - SIZE. You can set a working state on a single ID member, in which manager does not include - All children.
You can also set the working status on multiple iD members, manager uses Include - All Children. To change a work state - Select the work state, click the Edit button at the top. You can set from the above fields Controlled by. To remove a work status, select the work state and click Delete. Book editions can publish books on the PCB web. Administrators and energy users have the ability to create report
books by collecting series of reports. You can select an output in the form of a printer copy .pdf file, which can be stored on the server. You can use the book publishing assistant for this. Switch to ePublish and select the Book Edition assistant from there. It will open Book Publishing Wizard → Publish now as shown in the following screenshot. You get two options - Publish on a PDF file or print on a printer.
To remove books from the PCB web, go to the PCB administration. Select the administration configuration action component → manage the books. Select the book you want to manage using the checkbox and click Delete. SAP BPC - Word integration It's easier to integrate BPC with MS Word and create reports. BPC 10.0 10.0 The ability to integrate and report directly using Microsoft Word and
PowerPoint as well. PCB version 10.0 of NetWeaver helps you combine PCB features with rich features from Microsoft Word, Excel and PowerPoint. By using PCBs for the desktop, you can use all of Microsoft's default features and worksheets, presentations can be directly related to the PCB database. The following tasks can be performed for customer maintenance. Reset the Current View Bar Clear
Local Application Information Update Dimension Members update dynamic templates Set local folder for planning and consolidation for customers You can open these interfaces via PCBs Web → List of available interfaces Publishing from Microsoft Word Go to File - Save As. Select Save as a web page as shown in the next screenshot. Enter the file name and select the web folder that shows the location
of your PCB application set. You can select from the following directories - AppSetPublications - Used for publication that applies to all AppSet applications. [application] - Used to publish for a specific application. _private - User-specific. Once you select the directory, click Save icon. SAP BPC - PowerPoint Integration As we've seen before, you can integrate PowerPoint with PCB 10.0. Publication de
PowerPoint Go to File → Save As. Select Save as a web page as shown in the next screenshot. Enter the file name and select the web folder that shows the location of your PCB application set. You can select from the following directories - AppSetPublications - Used for publication that applies to all AppSet applications. [application] - Used to publish for a specific application. _site - Used to publish for a
specific site. _private - User-specific PCB Sap - Essential Tools SAP BPC also provides essential tools - Documents (referential for storing files), Newspapers (to make adjustments to data in the database), statistics, audit, etc. Documents This provides a central repository for storing and sharing files and websites. There is a feature called Document View that can be used to publish, share and retrieve files
or content from a website. View files to view documents You can publish files or URLs to add to the view of documents. You can set the description, set the access, and determine if you want to send an email notification to the document. You can save a file on a local disk or network folder. Files with extension can be downloaded - XLS, . Xml. Mht. Mhtml.HTM, XLT, . Doc. Html. Xlsx. . xlsm. XLSB, . Zip.
Pdf. Pptx. Pptm. Cdm. Tdm. Png. Gif. Jpg. Css. Mrc. Point. Pot Ppt. POTX, . POTM, . Docx. Docm. DOTX, . The DOTM PCB administrator can also change the environment settings (DEFAULT_EXTENSIONS) to allow for the release of other files. The categorization of documents, sorting and filtering documents are also possible based on the following - type of document and subtype Type Of access rights
to the context of the Date of Access to the type of document model, go to bpc Web Portal → Administration. On the left side of you can select 'Functionalities'. Once you expand the features, you'll get an option for document types. You can select the type of document and the subtype from here and edit. Audit Audit allows you to create reports that contain user session history and system information. You
can create audit reports on the following topics - Business Process Flow - You can create these reports in GMP. Security - You can create these reports in Security. User Team Task Profiles General GMP Data Access Profiles - You can create these reports in general. State of the Work Administration Activities Comments Changes to data Creating audit reports go to the Business Planning and
Consolidation Administration. On the left side of the screen, you can create audit reports. Once you click on the Audit tab, you'll see all three reporting options. To create a report, click on any type of report. Select the audit level - model, instance and duration and click View. Similarly, you can create security and general reports. Journals in PCBs are used to update the data in the database. This is normally
done to display end-of-quarter or year-end data in PCBs. Example Suppose an administrator has downloaded general information about the ledger in an application that the regional manager must review using the data manager. The regional manager can make the necessary changes to the data by entering the log. Here are the tasks that can be performed from the log manager. If you have an open log
entry, you can run them from Journal options. Navigation of tasks Creating a log entry This can be done using the action pane Change a log entry backup as an option can be used to save the log entry with a new ID Copy a log entry From the log list, select a log entry and copy to confirm the search for a new Journal Select Manager's Journal request Reopen a Select Journal log entry functions that can be
performed using Journal Manager or Action Pane. To create, edit, delete and change log settings, go to business planning and consolidation administration → features. Expand the Feature → Select Journals tab. From there, you can create new journals, delete the template, log settings, delete reviews, etc. SAP BPC - Business Process Flow Business are used to guide users with a predefined set of
application tasks. These steps must be performed in a series and may have sub-steps too. The sub-steps of the process flow should not be run in a sequence and may not be necessary for each iteration. Also note that business process flows can only be defined for end-user tasks and not for administrative tasks. The following business process flow features can be used - Personal To-Do List This list is
used to show the steps and sub-steps assigned to you or the completed steps you need to review. This is called the stage regions. The to-do list contains the name and status of each stage region. They may have the Measures Required - Waiting for completion of the new stage Required review - The stage is awaiting review and the steps are completed - The step is completed Rejected - The stage has
not met the conditions in the completion state Waiting - The stage waits for the stage to be reopened There are various other to-do list statuses such as reopening , waiting for the appropriate condition of the work, waiting for the reopening and unavailability. Reopen and reset You can also reopen a completed step or reset a particular instance or set of business process flow instances. To reopen a step, it
must have the following criteria - Allow the re-opening attribute must be included in the step. The status of the stage must be complete. You can only open one previous step at a time and the steps can be opened in a sequence. If a step has an Activate Reviewers attribute, users cannot reopen that step directly, but can send an email request to the reviewer. The user has reopenBPFStep task security
mission. Completed Steps All completed steps are system-checked and displayed in the report. Locked Dimension Priority All locked dimensions that are not specified in the current business process flow view remain locked in any open worksheet. Copying a business process flow - Connecting to the administration of planning and consolidating → business process flow. The list of all GMPs is displayed.
To copy a GMP, select GMP and click 'Save As'. Enter the name and description of GMP and register as GMP. Similarly, you can reset a business process stream, using the manage option by selecting reset process flow instances. SAP BPC - Custom Menu Personalized Menu provides a summary of a business process and also provides a link to useful information used in the process. PCB administrators
are responsible for creating custom menus and assigning access rights so that only the required people see those menus. You may be able to have multiple users with different access rights on a single custom menu. A custom menu is defined using a custom menu template. EV_MENUSTYLE custom menu template worksheet is used to define the format, content, functions and settings of the custom
menu. Designing a custom menu You can use a custom menu template to define the format, content and functions in the custom menu. You can use sample templates in ApShell or create a custom menu by creating a new sheet working in an existing menu. The sample template contains several worksheets - EV_DEFAULT - Set the content of the personalized menu. EV_MENUSTYLE - Set the custom
menu format. ADMINGROUP - It's the same as EV_DEFAULT but only edited for users of the admin group. To create a custom menu template, head to PCB Excel eTools → custom menu manager → Open Custom menu. You can find examples of custom menu templates under EXCEL/Reports/Wizard/ProcessMenu. There are various custom menu functions that can be used to perform various common
activities such as HIGHLIGHT OPENLOCALFILE NAVIGATION OPENWEB, WHERE LODRY OPENLOOKUP OPENMYEVEREST OPENURL CHANGEGROUP PUBLISHBOOK Custom Custom Custom Content The content of the custom menu is defined by two sections in the custom menu template - default section and menu element section. The following default settings can be set for EVDEFAULT.
NormalSCREEN Value Options Settings Is True - It opens the custom menu in the Excel interface. The value is wrong - It opens the custom menu in Standard Excel. HIDEEVTOOLBARS If the value is true - it will hide the planning and consolidation toolbar. If the value is wrong - it will display the planning and consolidation toolbar. CVLIST It is used to define the dimensions that should be displayed at the
top of the custom menu page. These dimensions can be changed in the report mentioned in the Personalized menu. The Menu Element section includes the following settings - Menu Element - Text Description that the user can select for the menu item. Actions - Highlight, custom menu function or menu order. Level - The level can be selected from a section, item or sub-element. Settings - For custom
menu functions. Normal screen - Default is full screen. This is true, custom menu opened in CVOverride normal screen - this is used to change the current view dimensions when switching applications. SAP BPC - Consolidation SAP PCB Consolidation Module is used to manage and prepare consolidated data and provides a correct view of consolidated data in an organization. The consolidation module
also provides an environment for performing consolidation tasks on the web. In sap Business Planning and Consolidation NetWeaver version, you have a consolidation monitor that is used to manage consolidated data reported by groups and members of the entity. The consolidation monitor also controls the reported data. Central Consolidation contains reviews, which are used to create and manage log
entries for consolidated data updated in the database. It contains ownership manager to manage property-based hierarchies. The configuration of environments and the master data setting up environment include managing the master data load once you have completed the installation of PCBs. Business users can set up to update the master data every night or week. This can be done in a number of
different ways. The first option is that you download the data from the SAP BW system to a flat file and then using BPC DM Manager loading the data from the flat file to the PCB dimensions. Another option is to load the data directly onto the PCB dimension via SAP BW Transformations. The choice of option depends on your company's requirement know what solution needs to be implemented. The
following steps illustrate how to import a transport and create a new data manager package to handle the importation of key data. The first step is to import the transport - Transaction code: STMS The next step is to create data manager package to load from the application server. Open PCB Excel and log in. Go to Action Pane and select Manage Data. Now, to create a new package, go to maintain data
management → manage packages. To create a new package, click right on the empty area and select Add the package. Click on the process chain dropdown option and select select Click on select. Enter the name and description of the package. Click Add and Save. Now go to manage the Packages option under maintenance data management. Select the package that was created in the previous step
and click Edit. In the next window, click View the package, then click the Advance button. In the next window to keep the script dynamic, click OK. Click 'Save' and 'OK' and close the setup. The creation of consolidation model models is used to maintain relationships, calculations and data in an organization. There are two types of models that can be created - Non-reporting model We use reporting models
for analysis. Non-reporting modules include the pilot model and tariffs and are used for exchange rates, price, property data, etc. Types of reporting models - Here are the types of non-reporting models. Consolidation Finance Generic types of non-reporting models - Here are the types of non-reporting models. Note that you can report on non-filed models, but you can't assign them the state of work. To



create a model, connect to business planning and consolidation administration. Move on to the dimensions and patterns on the left side of the screen, click on the Models tab. To create a new model, click on the New sign. In the next window, you need to enter the Id model and description and switch to the Next button. Select the model type - Reporting or Drivers and Rate and click 'Next'. In the next
screen, you have the option to select a blank model or you can copy from an existing model. Once you then select, in the new screen, you need to select the dimensions to include in the new model. You need to add specific dimensions depending on the type of model. Click 'Next'. In the last window, you will get a summary and create the option. Click on the Create option to create a new model. Similarly,
you can copy an existing model. Creating the Logic of Consolidation Logic Is defined as calculations performed at different levels. Executing the logic of consolidation requires a kind of expertise and commercial requirement. Logic can be defined at different levels - in a dimension using Microsoft MDX language. With the help of scripts. Use of business rules executed with pre-defined business
requirements. PCB Excel formulas. Logic can be executed at different levels - PCC Application Server Excel/Live Reporting Analytics Services Creating a logical consolidation connection to business planning and consolidation administration → rules. Logic Scripts on the left side of the screen. Select the model on the right side of the screen. Click - New sign and enter the name of the Logic Script file. Go to
the 'Create' button. Enter the Logic script and click 'Valider'. Once the script has been validated, click the Save button. SAP BPC - Elimination Preparation To perform currency conversion and intercompany disposals, you need a size type - Intercompany Dimension (I). To perform intercompany elimination, an application must have the following dimension - Dimension Type I intercompany elimination.
Dimension I should include a property entity. The size of the account must include the ELIMACC property. The size of the entity must include the ELIM property. You need to set the appropriate business tables. There should be a TPD package to run intercompany logic. Dimension Property Length Content Account ELIMACC 20 Valid Account Entity ELIM 1 tank It contains 'Y' or blank Intercompany Entity
20 Entity 20 Entity 20 Entity w.r.t Intercompany member Currency Reporting 1 'Y' or blank defaulting logic performs the following functions - Checks all base-level entities where ELIM-Y. limits the monetary dimension to all declaring currencies only. It removes all accounts to be eliminated in the desired plug account. Elimination is performed below the first common parent in elimination entity. Central
CONSOLIDATION SAP PCC Central Consolidation is used to manage and prepare consolidated data and provides a correct view of consolidated data in an organization. The consolidation module also provides an environment for performing consolidation tasks on the web. Here are the main features of Consolidation Central - Consolidation Monitor In the SAP Business Planning and Consolidation
NetWeaver version, you have a consolidation monitor that is used to manage the consolidated data reported by groups and members of the entity. The consolidation monitor also controls the reported data. It is one of the key components while performing incremental consolidation as it communicates with the consolidation engine to perform currency translation execution. The consolidation monitor also
displays the group-entity hierarchy defined in the property manager. Using the consolidation monitor, you can run the full consolidation that contains the group-entity hierarchy. You can also gradually consolidate with only updated features. Central Consolidation Journals contain journals that are used to create and manage log entries for consolidated data updated in the database. Property Manager It
contains the property manager to manage property-based hierarchies. Control Monitor It is used to manage controls that are used to validate reported data. The implementation of log reviews in PCBs are used to update the data in the database. This is normally done to display end-of-quarter or year-end data in PCBs. Example: Suppose the administrator downloaded general information about the ledger in
a regional manager request to review using the data manager. The regional manager can make the changes data using log entry. Here are the tasks that can be performed by the Director of the Journal. If you have an open log entry, you can run them from Journal options. Navigation of tasks Creating a log entry This can be done from the Action pan. Changing a log entry record as an option can be used to
record the log entry with a new ID. Copy the log entry from the log list, select a log entry and copy to confirm. Search for a new Journal Select Journal request from Journal Manager. Select Select Journal reopens There are other log entry functions that can be performed using the log manager or action window. To create, edit, delete and change log settings, go to business planning and consolidation
administration → features. Expand the Feature → Select Journals tab. Using this, you can create new journals, delete the template, log settings, delete reviews, etc. Translating local currency Translate local currency means converting the amount into source currency into the target currency. You can translate currencies at any group/entity level. The translation of the local currency is done in the
consolidation center of the system of planning and consolidation of activities. To run currency translation on a specific entity, your PCB administrator must grant you writing access to that entity. Here are the main facts in the execution of the local currency translation - Category - This includes categorizing the reported data to which you have linked the translated amount. Time - It shows the period of data
entry during which the amount to be translated was entered. Reporting Currency - This tells you to select the currency in which you want to run the translation. Group/Entity - This defines the areas on which translation is carried out. Translation execution mode - You can complete a full translation of the local currency or choose an incremental translation. Rate Entry - This contains the exchange rates to
select when translating currencies. Translate currencies Go to the PCB web portal → Select Consolidation Central. Switch to Consolidation Monitor after the expansion of Consolidation Central. Select the entity/group line for which you want to translate currencies. In the next dialog box, select The Execution mode - full translation or incremental translation. Click 'Ok' after selecting the fields. SAP BPC -
Configuring Elimination In BPC, it is necessary to configure intercompany disposals between subsidiaries or parents to avoid double counting. Intercompany disposals are done using the logic of the script. If you have transactions between subsidiaries Co. XP02, XP03, these transactions should be eliminated. These transactions are for intercompany accounts payable and accounts receivable, as well as
intercompany sales and costs. Setting up intercompany disposals Before you do intercompany disposal, you must have the following preconditions - A consolidation environment You must convert currencies before disposal. To begin with, first create a dimension for the elimination of IC. Application where you need to perform IC must have the I and R dimension for the account and rate. The size of the
account must have a disposal account property to display the IC transfer balances. ID EV Description Account Dimension Property ICCost ICCost IC Cost of Sales ICDiff ICSales IC Sales ICDiff ICDiffRec ICAccRec IC Accounts Receivables ICBal ICBalPay ICAccPay IC Accounts Payable ICBal Next is to have a Entity dimension with an ELIM property (Y/N) to display entity's results. This property is set to
Y for the elimination entity. Account Size I must have an ENTITY property and must be maintained - XP01_Input XP02 XP03 XP04 XP05 Your monetary dimension R must have a 'Reporting' property and must be maintained - IC disposal is managed by built-in procedures - INITIALIZE_ELIM and ELIMINATE_ORG. Both procedures are maintained in ICELIMWITHCURR. File LGL. The following logic must
be entered into the application ICELIM logic file and must be validated and backed up. Logic for intercompany elimination / //SYSTEM_CONSTANTS LGL -ICELIMWITHCURR SYSLIB. Once the above configuration ELIMINATE_ORG INITIALIZE_ELIM is in place, you need to create an entry schedule or import package to load the data to be eliminated. To run the import package for IC disposal, connect to
PCB Excel. Click Manage data and run a data management package. Go to the company application folder, click on process → select IC removals from the package and click Run. Once this package is successfully executed, you can check the values of the following components in the statement of profits and losses and balance sheets. ICCost IC Sales Cost ICDiff ICSales IC Sales ICDiff ICCccRec IC
Accounts Receivables ICBal ICBal ICAccPay IC Accounts Payable ICBal The review of ownership and ownership conditions of concepts is managed by the property manager. The property manager is used to manage property-based hierarchies. These hierarchies combine groups and entities, and these entities can be connected or disconnected from groups by category and time. Property-based
hierarchies are used to meet reporting requirements that cannot be managed using fixed hierarchies. To view the property manager, log on to the home page of the PCB web portal. Go to The Central consolidation on the left side of the screen → owner. To create a property-based hierarchy - Switch to the property manager as mentioned above. Click on the Edit option provided in the property manager. In
the next window, you will have the option to add members to the hierarchy. Click the Add button and you'll be able to select members. Once the hierarchy members are added, click the Save option in the top right corner of the screen. Method of purchasing Method of Purchasing method is sometimes also called the global method. Business Planning and Consolidation supports the following consolidation
methods - Global Method (Purchase) Proportional Method of Equity Method Global/Purchase Method In this method of balance sheet accounts and profit and loss accounts are fully included and minority holdings are calculated if necessary. Proportional method you include the balance sheet and P-L accounts as a percentage of ownership. Example - Including the status and balance sheet of P and L are
included at 50% of the percentage of ownership. Equity Method In this method, you do not include balance sheet and balance sheet accounts. However, net worth and result of the period are included. SAP BPC - Embedded Environment BPC Embedded model is based on business warehouse-integrated planning (BW-IP) in which it uses BW objects directly. This model is different from the standard model
and includes access to data to all users in the community. For the on-board design model, the initial versions used were sap BW Integrated Planning and Planning Application Kit i.e. BW-IP and PAK. This model offers a different level of data access where master and transactional data from the EDW host environment is accessible through the application. In the Embedded model, it provides easy access to
transactional and master data within the BW host, and this data is shared with many other users and controlled by the group of administrators. In the Embedded model, the migration of older versions of BW-IP to this data model is relatively easy and the migration of earlier versions like (PCB 10.0 and earlier) is considered a new implementation. In short, you can say that in the built-in model, any number of
InfoProviders can be attributed to a single PCB/application model. Here are the key features and features offered in the integrated PCB 10.1 model - it uses exceptional real-time SAP HANA features and thus protects SAP HANA performance through the planning application kit. The use of SAP HANA allows you to perform certain planning functions such as copying, distributing, etc. Pcb-integration
planning supports the use of infoProviders and aggregation levels in real time. The embedded model supports sap BW Requests that you can run directly into the SAP EPM add-in for Microsoft Office. The integrated model provides verification functions to enable the creation of various audit reports and the use of business process flows. SAP BW Integrated Planning SAP BW Integrated Planning provides
BPC experts with an infrastructure to create and operate planning scenarios. This includes planning common data entry processes for complex planning situations. SAP BW-IP Planning Model Planning model in BW-IP includes - Data stored in InfoProviders for Planning. The structured view of the data includes aggregation levels, multi-supplier relationships and characteristic relationships. Data modification
includes planning functions, planning sequences, manual planning in the form of ready to enter and process chains. Utilities, that is, filters that can be used in queries and planning functions. Central data protection. BW Modeling Tools The following tools can be used for model planning scenarios - BW modeling tools in Eclipse and the data storage facility to create BW data models. Planning modeling to
model planning-specific metadata objects. BW modeling tools in Eclipse and also BEx Query Designer to enter plan data manually. BEx Web Application Application or BEx Analyzer (Excel applications) to create planning applications. Applications to run on the web or in BEx Analyzer to enter data manually. Creating a data model in sap BW Transaction Code: RSA1 A data model is defined as an
information cube in SAP BW, which consists of fact table and dimension tables. To create an InfoCube - First create an information zone, which is a building block for an InfoCube. Enter the name and description of Info Zone and click 'Ok'. Then create InfoObject Catalog which is used to define key features and numbers for different types of objects. Go to InfoObjects on the left side of the screen. Select
the information area created above → create the InfoObject catalog. Enter the name and description of InfoObject Catalog, InfoObject Type and click 'Create (F5)'. Validate and activate IOC_Demo_CH to check the InfoObject catalog. To activate the InfoObject catalog, turn on the icon. Similarly, you can create infoobject catalog to keep key figures. Let's create InfoObject. Click right on InfoObject Catalog
IOC_demo_CH and select create InfoObject. Enter the name and description of InfoObject. Click 'Continue'. Select Data type with character and length as 15. Then click on the 'Attribute' tab. Enter the name of the attribute and click 'Create'. Select Create the attribute as features and click Create icon. Select Character as a data type and Length 30. Note that the Attribut only option is automatically checked.
Click on the green tick at the bottom. Click on Check and Activate to validate and activate features. Similarly, you can create InfoObjects for key numbers. Once you set InfoObjects for key features and numbers, create an InfoCube. Click right on Info Provider Demo → Create InfoCube. Enter the InfoCube name, select the standard for the InfoCube description, and click Create. Select the characteristics of
the model table and move them to the structure table with arrows. Click on the Dimensions tab to assign these features to the dimension. Click Create and add a description of the dimension. Once you assign all the key features and numbers, validate and activate the InfoCube. SAP BPC - Security Security in SAP BPC system is defined using two components - Authentication and authorization.
Authentication defines who can access the system and data, while permission indicates the level of access for each authenticated user. SAP PCB security is based on access profiles and task profiles. When you don't assign task profiles to users or teams, no access to PCB tasks will be provided. This requires you to assign access to members of a secure size. BPC Security provides the following key
features - Add teams to users Add task profiles Add Member Access Profiles To manage the above functions, connect to THE PCB administration and access security. There are four tabs under Security - Users - This is used to add users to the environment and manage access rights. Teams - You can add the same rights to users to access the Team. Task Profiles - This is used to set up profiles that
allow you to perform tasks and assign them to users and teams. Data Access Profiles - This is used to set up profiles that allow access to data in models and assign it to users and teams. To add/edit/delete one of the objects under security, select the object as shown in the next screenshot. SAP BPC - Hot Analysis Hot analysis is used to set up a hot link to another report or cell in another report. EvHOT
functions are used by BPC Application Set and AP Shell to provide a sample report called Hot Analysis. Hot links are used by users for ad hoc reports and also used in process selector reports. This is used to switch from one report to another in different applications. Evhot Function Syntax EvHOT (AppName,ReportName,DisplayName,Member1,Member2,Member3,Member4, ....... Member N) You must
pass the following settings in the EvHOT function. App Name - This is the name of the app. Note that in the PCB system there is a setting in Workbook Option, which allows the system to remember the current view. By default, this setting is disabled. In this case, if you switch to a new application using EvHOT, it changes the application in the current view of the workbook and other reports you access this
session attempts to get data from that application. If this option is enabled, the current view returns to the workbook application setting when focusing. Report name - That's the name of the report. The root directory for PCB reports is the Wizard directory for the given application. When creating a report, use eTools → Save Template Library. View name - The text the user clicks to get to the specified
location of the report. Member1-Member N - This is the CurrentView member. Here you can mention as many members as you like. Example of EvHOT Syntax EvHot (Finance, Report2,2010 Quarter 2,2010.Q2 Note - This report must be stored in 'Reports'Wizard folder. The exact path is report wizard folder.. In the event of a new report, you will also need to increase the model version in the PCB
administration client. SAP BPC - Park N Go Using park n go feature, you can lock a PCB report and save it locally on your system as well as send the report by email to someone who does not have access to the PCB system. If you don't record the report with a correct setting or sequence, you get an error in the report that makes the report unusable. You can use the Park n Go feature for the Properly.
Here are the steps you need to take to use Park n Go - Connect to PCB Excel and open the report you want to park. Go to save → save my reports. You'll get a dialog box asking if you want to lock the report before saving it. Select Yes. In the next window, you'll get a message - Select a Park n Go state for an active workbook with four options. Once you click Ok, a report will flash and you'll get will get
Save as option. You can save the Report Excel to where you want to save. This option allows you to open the report in Excel and all the data will appear correctly in the report. Report.
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